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File Extensions
.MTH
.RUN
.XMS
.SMP
.SEQ
.RCL
.MLG
.MSR
.IRM
.MSF
.CDF

Method
GC Detector Data
MS Data
Sample List
Sequence List
Recalculate List
Message Log
Report File
Dash Template
AMDIS Data File
Content Definition File

Routine operations with Scion MS Workstation are quite easy to set up parameters
for data collection and report generation . The following is a discussion of hidden quirks
that may not be obvious of their usefulness. This discussion assumes that the operator is
familiar with basic operations in MS Workstation.

Operations involving control of Scion 436/456 Gas Chromatographs.
1. To maintain interconnection between instrument and MS Workstation, System Control
should be closed before powering off the GC. Reconnection becomes automatic. If
needed, the reconnection can be established by viewing video at
http://lotusinstruments.com/reconnecting-a-456436-in-ms-workstation-8/.
2. Full access to methods through instrument display, even active one, during data
collection.

3. GC Remote Control - allows view of status of
gas chromatograph from a remote computer,
typically through Team Viewer or similar app.

4. Reboot gas chromatographs through GC
Remote Control by setting a minor change
to System Time through Setup > System.

5. Change run time for gas chromatograph
during run, especially useful in method
development.

6. Instrument Log – lists activities for the
instrument, including faults with time/date
stamp.

7. Runlog - documents all actual run conditions on GC in every .RUN
file for full recovery at a later time, even changes made during the
run.

8. Automatic update of method when hardware
is added/deleted in Setup. All other hardware
and calculations remain intact.

9. FID/NPD Detector Full Scale - the
electrometer for these two detector types
has the ability to auto-range over the full
range of the detector. To activate this
feature, full scale parameter is set to 1000 V.

10. Resume plot – permits visible
display of active baseline drift
and noise.

11. Entry and display
of temperatures in
0.1 oC increments.

Common hints for both MS and GC detector operations

12. Concurrent instrument control and data
collection for MS and GC with single Method.
13. Concurrent data collection for MS and GC
with single SampleList.

14. GC chromatogram can be displayed in
MS Data Review, by right-clicking of
.RUN file in Windows Explorer.

15. Compute GC Detector
Peak to Peak Noise in
MS Data Review. Use
mouse to draw line for
noise calculation.

16. Compute GC Detector Root Mean
Square Noise in MS Data Review.
Open .RUN file in MSWS and use
mouse to draw line for noise
calculation.

17. Up to 50 calibration levels.

18. Recalc List – This screen allows selected
data files to be recalculated with a modified or
different method.

3.821 minutes

19. Determination of Retention Time - MS Workstation establishes retention time of a peak
by computing the zero crossover of the first derivative of the peak. It this value does not
correspond to a collected data point, precise timing is determined by linear interpolation
of points before and after the zero crossing.
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3.361 minutes
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20. Start and end points for peak integration are
always on the chromatogram tracing.

0
3.00
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21. Drag/drop .RUN files into Recalc list.

22. Create/update files to Recalc lists from
SampleList.

23. Sequence List – This screen permits
multiple actions related to using a series
of methods with multiple SampleLists or
RecalcLists. The related MessageLog can
be printed to provide documentation of
actions.

24. Notes - Free-form user commentary on various activities:



Method Notes.



Injection Notes.



Sample List.





Sequence List.

Recalc List.

25. Sample injection time/date and
sample name are locked at
time of data collection and
cannot be changed postrun.

Title :
Run File : c:\users\lotus\desktop\2020-07-31 14-57-42 test inj 1 - calibration 07-272020.run
Method File : C:\ScionWS\methods\Calibration 07-27-2020.mth
Sample ID : Test
Injection Date: 7/31/2020 2:57 PM Calculation Date: 7/31/2020 3:10 PM
Operator : Detector Type: 4XX-GC (10 Volts)
Workstation: Windows Bus Address : 44
Instrument : Canby Sample Rate : 1.00 Hz
Channel : Middle = TCD Run Time : 13.000 min

26. Batch Processing - icon accessible at Start > MS
Workstation > Batch Reporting. Easy and quick
approach to reprocess lots of similar data files by
highlighting desired data files in
Windows Explorer and dragdrop into window.

27. Automatic recalculation of data files with sequence list with different method immediately
following data collection, with no operator interactions, using Recalc file created with
.SMP actions.

28. MessageLog lists all system control
activities, documented with time/date of
injection, sample labeling, data file label
and location, and errors. These logs are
available for recall later.

29. Echo - This AutoLink application inserts a string in
the Message Log. Use the following syntax in the
AutoLink field in a Sample List or Recalc List:

command-line: echo
other-parameters: <descriptive text
to be "echoed" in the Message
Log>
30. Header block in System Control:









Listing of active method
Active automation file
Last data file collected
Active sample name
Injection counter
Number of calculated files
Button to reactivate active method

31. Live display of all valve activities on System Control
screen.

32. Direct access to SampleList from 8400
display by clicking on center of carousel.

33. Direct access to inject single
sample by clicking on vial in 8400
display.

34. Graphic
display
of
calibration
plot
by
Method
Editor
>
Calibration Setup >
View Curves for GC
detectors.

35. Graphic display of calibration plot for MS data
through Method Editor > Channel 1=MS Data > MS
Data Handling > Compound Table > View Curves.

36. Interconversion
of
detector
response
and
concentration per calibration curve. This calculator
allows anticipation of expected peak size for a given
peak size.

37. Edit out obviously invalid data points
in calibration plot by right clicking on
specific points.

38. Source of calibration data point
with Calibration Curve > Point
Info.

39. Edit/Lock Coefficients – When multiple
standards with differing analytes are
used, coefficients need to be locked
after they are calibrated so that the next
mixture does not alter them. In addition,
coefficients from related analytes can
be manually entered. For example, the
response values for propane with a
flame ionization detector can be
applied to other hydrocarbons.

40. Approaches to open method:





Task Pane.

Windows Explorer.



Method Builder icon.

41. Indication that Method file has not been saved with an
asterisk after the file name in the header. If not
manually saved, a prompt will appear for saving.

42. Activate method through SampleList .

43. Activate “Last Edited” method.

44. View multiple methods
side-by-side on one screen.

45. Tangent Percent for fused peaks - This compares the height of the rider peak to the height
of the mother. If the ratio exceeds the Tangent Percent value, a perpendicular drop is
executed, and peak is reported as “Valley/Baseline - VB”. If less than this value, a skim
is undertaken and marked as “Tangent Skim - TS”.
Perpendicular drop to
baseline at valley point

Tangent skim
of rider peak

Mother
Peak

Rider
Peak

46. Export SampleList to Excel.

47. Import SampleList from Excel.

48. Default entries simplifies construction of
SampleList.

49. Move columns in SampleList by
right-clicking in header.

50. Relabel column header in
SampleList.

51. Copy/paste lines in SampleList with “Shift – c” and then “Shift - v”.
52. Copy/paste lines in RecalcList “Shift – c” and then “Shift - v”.
53. SampleList AutoLink commands:


WAIT - This AutoLink application waits for a specified time before terminating; it can
be used to perform injections on a specific timetable.
Command: WAIT hours:minutes:seconds
Other Parameters: <none>
Hours
0-23
Minutes
0-59
Seconds
0-59
For example, WAIT 15:03:56 will wait for 3:03:56
PM, unless this time is already passed, in which
case there will be no wait. Fields can be omitted.
In this case, tailing fields are defaulted to zero, while leading fields are interpreted as
the next matching hour or minute. The following examples illustrate most useful cases:
13:

taken as 13:00:00.
13:10 taken as 13:10:00.
:13
taken as the next occurrence of 13:00 minutes after the hour. At 12:15, this
command would wait for 13:13. At 12:10, this command would wait for 12:13.
::13 taken as the next occurrence of 13 seconds after the minute



GOTO - This application jumps to another line of the sample list or log. Use the
following syntax in the AutoLink field in a Sample List or Recalc List:
Command: GOTO <line-number>
Other-parameters: Inject or Recalc or Print



WAIT and GOTO can be used to create an
infinite loop to perform an injection every
hour on the hour to monitor a process
stream.

54. “Verification” run type – Reported results
compared to values in a calibration level.

55. Access data file actions from Windows
Explorer.

56. Specify/Create data file directory from
Sample List.

57. Automatic
tokens.

data

file

naming

with

58. Data file names can have up to 255
characters.

59. Recent Files button. This action
significantly reduces errors in entry of file
name and directory path.

Suggestions for operations with .XMS data files

60. Single method for full control of both MS and GC detectors.

61. Compound Graph illustrates
scan times and effects of peak
window overlap.

62. Expanded view of portion of
Compound Graph.

63. Active Compounds Set
Editor - ACS is a list of
compounds, representing
a subset of the Compound
Table, which can be
saved in a method, and
activated
during
automation. MSWS includes an interactive
application (ACTIV2.EXE) to create, edit,
delete such sets within a method file. MSWS
also includes an automated application
(ACTIVATE.EXE) which can be invoked
within a sample list to activate one or more
sets in the active method.

64. Process Files.

65. Control Chart Reports.

66. Calibration Reports.

Target Compound Report for #1 from ...1 minute 07-23-2019 sim.xms

67. Compound Reports

Sample ID:
Instrument ID:
Measurement Type:
Acquisition Date:
Calculation Date:
Sample Type:
Inj. Sample Notes:

10 ppt - 1.67 ppt
Lotus Toxics
Area
7/24/2019 9:48 PM
8/23/2020 9:57 AM
Analysis
None

Operator:
Last Calibration:
Calibration Type:
Data File:
Method:

8/22/2020 7:22 AM
External Standard
...e 07-23-2019 sim.xms
... 7-29-2019\randy.mth

Compound Information
Peak Name:
Result Index:

Propene
1
Compound Number: 1

CAS Number: 115-07-1

Identified

Actual

Status

Identification
Parameter
Search Type
Retention Time
Match Result
Qual. Ion Ratio ( 2 ions )

Specification
Highest
14.356 +/- 0.200

14.362 min.
N/A
19.9% - 59.9%
2.1% - 42.1%

m/z 39.2:39.9%
m/z 42.2:22.1%

Pass
33.6%
25.4%

Pass
Pass

Integration and Quantitation
Parameter
Quan Ions
Calibration Equation
Area
Height
Amount (Conc.)

Specification
41.2+39.2+42.2
Linear, Ignore, 1/nX2
>=500

Actual

Status

y = +1.5401e+5x +7827.7959
234342
27970
1.500 nmol/mol

>= 0 nmol/mol

Pass
Pass

Sample Spectrum for Scan: 16300 RT: 14.362 min.
BP 39 (18277.094=100%) ...- 1.67 ppt inj 1 - master 1 minute
39
100%
18277.094
41
75%
12756.835

Quan ; 41.2+39.2+42.2 ((+) 41.2, 39.2, 42.2)

40

42
8798.809

50%
25%

35

0%
38

30

100%

40

41

750

75%

kCps

39

42

43

Reference Spectrum for Propene
Scan: 16282 RT: 14.356 min. ...3 minute 07-23-2019 sim.xms
41
999
39

m/z

42
649

50%
25
25%
0%
SI

38

EI

20

SS

39

40

41

42

43

Raw Sample Spectrum for Scan: 16300 RT: 14.362 min.
BP 39 (18277.094=100%) ...- 1.67 ppt inj 1 - master 1 minute
39
18277.094
41
75%
12756.835

ES

m/z

100%

15

42
8798.809

50%
25%
0%
13.5

68. Excel Report Templates
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m/z

69. Dash Reporting.

70. EnviroPro Reporting - provides detailed
information on reporting results for common
USEPA methods - 524, 525, 624.625, 8240,
8250, 8260, 8270, 8270, CLPVOL and
CLPSV. Tune Reports can be generated.

71. Multicompound Software - 19 templates allow various displays of target compounds,
tentatively identified and unknown compounds in 1) graphic and text, 2) graphics only and
3) text only configurations.
72. ToxProPlus MS Reporting Software - software includes three separate custom software
packages: multicompound software, ion ratio summary report software, and screening
software to aid reporting.

73. NIST
Automated
Mass
Spectral
Deconvolution and Identification System AMDIS - allows users to automate the
complex process of extracting data from
GC/MS data file. AMDIS works by finding all
of the ions that rise and fall at the same time
and associating them to a single component.
Once it has found this component it compares
it to a library of spectra and retention indices
provided.

74. NIST 20 and NIST 20 Upgrade - 350,704
electron ionization (EI) spectra -306,643
compounds, 43,774 replicate spectra (39,729
more compounds than NIST 17) and retention
indexes for 139,963 compounds.

75. Summary
Charts

Report

and

Control

76. .XMS data file for MS possesses:






Raw data points
Last computed results
Copy of last method used
Link to original method
Calibration data points

77. Selected Ions Monitoring (SIM) – Data from multiple ions can be collected to provide
positive matching to reference spectrum with use of multiple characteristic ions for
compounds.

78. To confirm identification of
a compound when only
selected ions are set in SIM
mode, qualifier ions can be
set up with ion ratios to the
base peak. A match is
labeled as “ID” in the final
report.

79. Wiley Registry of Mass Spectral Data, 11th Edition - Comprehensive mass spectral library
contains 775,500 mass spectra, over 741,000 searchable structures, and over 599,700
unique compounds.
80. Maurer, Pfleger, Weber Library, 2016 Edition - includes novel designer drugs and a broad
range of AIDS therapeutics, for a total of over 8,800 clinically relevant substances,
including more than 3,500 metabolites.
81. Rosner Mass Spectral Library of Designer Drugs, 2019 edition - provides comprehensive
data of novel psychoactive substances with 28,032 mass spectra, 28,032 chemical
structures, 21,649 unique compounds, 18,017 measured kovats indices, 353 opiates, 866
fentanyls, 996 cannibiminetics and 112 canniboids.

82. Convert .XMS files to Content Definition File - .CDF used by groups and organizations to share abstract
enterprise content management data. The files created in
this format are saved with the .cdf file suffix in an XMLbased data format.

83. ASTM E1947 - 98(2014) Standard Specification for
Analytical Data Interchange Protocol for Chromatographic Data. This app generates .CDF
files that can be exported/imported in other brands of chromatography software
compatible with AIA format.

Hints with operations with GC detector .RUN data files

84. Display of peak details in
Interactive
Graphics.
Highlight desired peak and
carefully drop straight down to
expose
other
peak
information.

85. Insert .RUN data file into MS
Data Review from Windows
Explorer by right-clicking on
desired data file.

86. ASCII conversion of
raw .RUN data points
through MS Data Review right-click
on
chromatogram.

2
slope = -0.0235 mV

Millivolts

1
0

87. Detector signal drift computed
through Trend Line of ASCII data points
via Excel.

y = -0.0235x + 0.0982

-1
-2
0

1

2

3

Time (minutes)

4

5

88. Change colors of displayed live chromatograms.

89. Display of live chromatograms in System
Control – single, double or triple, and
horizontal or vertical.

90. Set chromatogram display for
full screen.

91.
Add/remove
notations
on
chromatogram
in
Graphics.

extra
displayed
Interactive

5.806

5.310

3.821

mVolts

600

500

92.
To display a chromatogram in
external documents, such as Word, “copy”
from Interactive Graphics to Clipboard and
the “paste into the .docx. This action allows
the chromatogram labels to be edited and
comments added.

3.361

400

300

200

100

0

-68

2.5

5.0

7.5

10.0

12.5

15.0

17.5
Minutes

93. Interactive Graphic display
of retention time to 0.0001
minutes.

94. Detector frequency. This parameter
impacts data collection with number of data
points to define the peak and with noise level.

95. Display of data points provides visualization
of proper definition of peak shape. Data
interval is set by detector frequency and
expected peak width.

mVolts

3

0

6.300

6.350

6.400

96. Single method possesses:
 Full set of parameters for control of GC
 Full set of parameters for computation of results
 Calibration data points
 Formatting for chromatograms and reports
 Baseline subtract data points






97. .RUN data file for GC detectors possesses:
Raw data points
Last computed results
Copy of last method used
Link to original method
Baseline subtract data points

Minutes

6.450



Calibration data points

98. Fill Peak Table is accessible
through Interactive Graphics.
Clicking on peaks in the displayed
chromatogram will add these
peaks to Peak Table of active
method.

99. Graphically relocate retention times in
Peak Table by right-clicking on yellow window
under peak and move to adjust.

100.

Add timed events by right-clicking in window below the chromatogram.

101. Deletion of timed events in
Interactive Graphics can only be
performed in “Tile” mode.

102. Graphically relocate time events with
mouse.

103.


Reporting of Results:

Set up for automated printing at run
end with Automated Printing enabled.



Set up printing parameters in method.



Access data files from Windows Explorer.

 Interactive Graphics allows up to
seven
chromatograms
to
be
displayed. If chromatograms are
displayed in “tile” mode, as specified
in Interactive Graphics > View >
Layout, then right-click with mouse in
any of them offers its report to be
displayed or printed.

104. Replicate Treatment
in Method Builder - Preset
value is set to Average
Calibration
Replicates.
Often the individual data
points are desired to be
indicated separately and
this parameter can be
changed
to
“Keep
Replicates Separate”.

105. Replicate
Tolerance
in
Method Builder - Preset value is
set to add replicates within a tight
tolerance of 0.5%. Better choice is
either to widen the tolerance or
“Always add new replicates”.

106. Baseline Subtraction - The baseline run
is a reduced set of 257 to 512 data points
across
the
chromatogram
run
time by a bunching
process, is stored
within the method
used for its collection
and is subsequently
subtracted
from
sample runs prior to
peak
detection.
Baseline Subtraction
is
activated
by
enabling it in Method
Builder > Integration
Parameters
>
Subtract Blank Baseline, and by indicating the first run in a series in SampleList
as Sample Type – “Baseline”.

107. Grouping by time interval – detector response can be grouped over a userselectable time interval. This process is often used for grouping non-methane
hydrocarbons in EPA Method 25, and for summing up all hydrocarbons in
natural gas for Hexane+. Assigned retention time for the group is the midpoint
between and starting and ending points.

108. Grouping
computations

by peak label –
are perfomed for

After
peak

concentrations, selected peaks can be grouped by peak name. Examples
include summing up separate peaks in measurement of polychlorinated
biphenyls, toxaphenes, and aromatic hydrocarbons.

109. Master/Slave Gas Chromatographs – Some applications require more
hardware capabilities than are available in one instrument. By combining two
gas chromatographs in a Master/Slave configuration, accessible resources are
doubled. One gas sample is loaded into both instruments, and the master then
starts both concurrently. A single method loads parameters for both

chromatographs.
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